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Introduction 

The Switcher™ Construction Kit is a powerful timesaver. It lets you 
use several applications on the Apple® Macintosh'" computer at the 
same time. The Switcher Construction Kit (called simply Switcher 
throughout the rest of this manual) clivides available memory and 
allocates portions of it to different applications. You can start two 
or more applications in turn and change between them instantly. 
You can work on a sketch in MacPaintTM, switch to MacWrite™ when 
you get an inspiration for your novel, switch to a spelling checker 
and look for typos, and then switch back to MacPaint and continue 
with your sketch-all without returning to the Finder. You can even 
have the best of two worlds: With the Finder installed as one of 
Switcher's applications, you can do all your computer housekeeping 
(copying, renaming, and removing documents) without ever 
leaving Switcher or quitting an application . 

• :. By the way: You set up a particular combination of 
applications only once; then you save information about that 
combination in a Switcher document. When you open that 
Switcher document from the Finder, Switcher starts each 
application automatically. 

What you need to use Switcher 
Switcher works with any computer in the Macintosh family having at 
least 512K of memory. It works most efficiently if you have an 
external disk drive or a hard disk to hold applications and 
documents. All the examples in this manual assume you have two 
disk drives . 

• :. Single-Drive Switcher: You can use Switcher with just one disk 
drive, but you'll have to make a large number of disk swaps. For 
all reasonable purposes, you'll need a second clisk drive. 

What you need to use Switcher vii 



viii Introduction 

This manual also assumes you are familiar with your Macintosh 
owner's guide and with the Finder. Chapter 1, the tutorial, assumes 
you have access to, and are somewhat familiar with, MacWrite and 
MacPaint (although any two applications will do). 

How Switcher works 
Switcher acts as an intermediary between Macintosh applications 
and the Macintosh operating system. Usually, an application 
"talks" to the operating system directly. In order to create its unique 
environment, Switcher intercepts and replaces certain operating 
system commands. 

You install each application that you want to use in a Switcher 
application slot. (See the first figure in Chapter 1.) Switcher 
automatically allocates a specific amount of memory to each 
application slot as the application is installed. You can override 
Switcher's automatic memory allocations, giving more or less 
memory to an application as the case demands. 

Switcher also controls how applications appear on the screen, 
letting you rotate through the applications as if they were on a 
wheel. 

MacPro'ect 

MacPaint Switcher MacDraw 

~~I~I~o~~ 
~U 

.MacWrite 



About this manual 
'This manual gives you the information you need to create and to use 
any number of combinations of your favorite applications. 

Chapter 1, Learning Switcher, leads you step-by-step through 
Switcher's basic features. Go through this tutorial ftrst, at your 
computer. 

Chapter 2, Using Switcher, tells you more about each Switcher 
feature, from the simplest to the most complex. Read this chapter 
to expand your knowledge about Switcher after you've gone through 
the tutorial. 

Chapter 3, Menus, provides a synopsis of the commands on 
Switcher's menus, in the order that they appear. 

Chapter 4, Customizing Switcher, shows you how to use each 
Switcher option to its best advantage and how to segment your 
computer's memory in the most efficient way for your work. Refer to 
this chapter when you want to put polish on your Switcher 
documents. 

Chapter 5, Particular Software, Particular Hardware, gives specific 
recommendations for using Switcher with some of the most popular 
Apple software, induding the Finder, MacWrite, MacProjectTM, 
and more, and provides tips about installing Switcher with different 
types of hardware (such as hard disks and the LaserWriter™ 
printer). 

About this manual ix 



x Introduction 

Make a backup now! 
Make a copy of the Switcher master disk; then put the original away. 
Use the backup copy any time you want to transfer Switcher to 
another disk. That way, if some disaster happens, your original will 
still be intact. Make the backup copy now, before you go on. See 
your computer's owner's guide for instructions on how to copy a 
disk. 

Switcher's limitations 
Although Apple has tested Switcher and is satisfied with its 
performance and reliability, Apple cannot guarantee the reliability 
of any particular application or combination of applications used 
with Switcher. Some software designed exdusively for the 
Macintosh 512K, for example, might not work with Switcher. This 
manual helps you achieve maximum reliability by identifying 
potential problems and by suggesting configurations that work well. 
See the inside front cover of this manual for the complete text of the 
warranty. 
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This brief tutorial takes you step by step through Switcher's basic 
features, using MacWrite, MacPaint, and the Finder as sample 
applications. You'll need a Macintosh with at least 512K, an 
external disk drive, MacWrite, MacFaint, your Switcher disk, and 
two blank disks. You should be familiar with MacFaint and 
MacWrite. 

Getting started 
You'll set up two disks to use with this tutorial. First, you'll create a 
disk called Inside Disk; it will become your startup disk. 

1. Copy your Switcher disk (including the System Folder) to a blank 
disk. 

2. Copy MacWrite (the application only, not the entire disk) to the 
same disk. 

3. Name the disk Inside Disk. 

Now you'll create Outside Disk; it will go into your external disk 
drive. 

1. Copy the MacPaint application to Outside Disk. 

2. Copy any MacWrite or MacFaint documents you'd like to use to 
Outside Disk. (You don't really have to do this step now; but you 
would do it in everyday Switcher use.) 

3. Label the disk Outside Disk. 

Your two disks should now be set up like this: 

Inside Disk 

System Folder 
MacWrite 
Switcher 

2 Chapter I : Learning Switcher 
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MacPaint 
MacFaint and MacWrite documents (optional) 



Starting Switcher 
1. Choose Shut Down from the Special menu. 

2. Insert Inside Disk into the internal disk drive and Outside Disk 
into the external disk drive. (If you're using a Macintosh XL, 
you'll need to turn it on.) The Finder starts and the disk icons 
appear on the screen. 

3. Open Inside Disk and open the Switcher icon. After a few 
moments , you'll see the Switcher display: 

" F"ile I dl1 Switcher 

, Switrher 

~ Doub le- el1d: here to launch ~n tl pp li cation ... 

~ Double -cl ick here to l1lUnch an appl ica tion ... 

~ Double-cl ick here to launch an applictlt ion ... 

~ Doubl e- click here to lounch en app lica tion ... 

The section called "Starting Switcher" in Chapter 2 gives a full 
description of the Switcher display. (But you don't have to go there 
now to work with this tutorial.) 

Starting Swi tcher 3 



Installing applications 
After you start Switcher, you designate the applications you want to 
use by installing them. Before you start, check to see that the correct 
Switcher options needed for this tutorial are checked. 

1. Choose Options from the Switcher menu. You'll get the Options 
window. 

2. Check Back After Launch and Switching Animation. Uncheck any 
other options that might be checked. 

3. Click OK. 

Application Switcher Options 

D Switcher in Rotation 

D Always Conuert Clipboard 

[2] Switching Rnimation 

[2] Baclc After Launch 

D Same One Twice 

D Reuerse Switch lIirection 

D lIisable Keyboard Switching 

Cancel 

Now you're ready to install applications. First you'll install the 
Finder. 

1. Position the Pointer anywhere in the first slot and double-click. 
You'll see the applications available on Inside Disk Finder and 
MacWrite. Of you're using the hierarchical file system, you might 
need to double-click on the System Folder to see the Finder.) 

2. Select Finder and click Open. 

4 Chapter 1: Learning Switcher 



• file ! dlt Switcher 

Rpplication Switcher 

e System Folder 

D Fmder 'f {g] Inside Disk 

Eject 

Drive 

Open 

Cance l 

- m; 

The Finder's screen appears briefly, and then you return to the 
Switcher display. You'll see the Finder in the flrst slot. Now you can 
install the next application, MacWrite. 

• Position the pointer in the second slot, below the Finder, and 
double-click. 

• File I dlt Switcher 

Rpplicat ion Switcher 

[g} Inside Disk 

"'\ MacUinte ~ {g] I nside Disk 
D System Folder ~ 

Eject 

Drive 

Open 

Cancel 

- 1::K IJBIB co JdUJICII al! dppJICdlJOJ! 
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Your only choice is MacWrite this time; you won't see the Finder 
because you've already installed it. 

• Select MacWrite and click Open. 

The MacWrite screen appears briefly, and then you return to the 
Switcher display. Now install the last application, MacPaint, using a 
different technique-just for the practice . 

• Choose Install Application from the Switcher menu. 

Choosing Install Application is the same as double-clicking a slot. 
You don't need to select a slot; Switcher automatically installs the 
application in the next slot You're presented with no choices, 
because you 've installed both applications on Inside Disk. But you 
can install MacPaint, which is on Outside Disk. 

1. Click the Drive button. You're presented with the choice on 
Outside Disk, MacPaint. 

2. Select MacPaint and click Open (or just double-click MacPaint). 

The MacPaint screen appears briefly, and then you return to the 
Switcher display. Three slolS now hold application names-Finder, 
MacWrite, and MacPaint. 

SWitching arrow'----------------------------, 

Finder s lot----------t---+---;~------
Finder ~ 

192K 

MacWrite slot--------j'---j--r-------
MacWrite ~ 

128 K 

MacPaintslot---------t---+--:------
MocPaint Il 

128K 

~ Double- click here to launch an opp llcBtion .. . 
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Switching between applications 
From the Switcher display, you can go directly to an application by 
double-clicking its slot, or you can click the switching arrow (it's at 
the upper-right corner) to rotate between Finder, MacWrite, and 
MacPaint. 

• Double-click the Finder slot. 

SWitching arrow----------- -------------------, 
It File Edit View Spechtl 

You'll switch to the Finder screen, familiar but with one difference: 
You'll see the switching arrow on the right side of the menu bar. You 
can do anything you'd ordinarily do in the Finder, such as copy, 
remove, or rename documents. But for now, use the switching 
arrow [0 switch to MacWrite. 

SWitching between applications 7 



• Click the right side of the switching arrow. (You might have to 
press for a second or two.) 

The Finder display rolls away and MacWrite rolls in. Type a few 
words; then switch again. 

1. Click the right side of the switching arrow. MacPainl appears on 
the screen. 

2. Again, click the right side of the switching arrow-the Finder rolls 
in. You've completed the circuit of your applications. 

3. Click the left side of the switching arrow. You return to the 
previous application, MacPaint. 

Think of the applications as if they were on a sprocketed wheel. 
When you click the switching arrow, you move the wheel forward or 
backward, one notch at a time . (See the figure at the end of the 
Introduction to this manual.) 

• Make a few swirls with the paintbrush while you're here in 
MacPaint; then go OfL 
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Returning to the Switcher display 
You'll need to return to the Switcher display if you want to change 
settings or add applications. Switcher adds the command, 
Switcher, to the bottom of every application's Apple menu. 

• Choose Switcher from the Apple menu. 

Choose Printer 
Scrapbook: 
Rlorm Clock: 
Note Pod 
Calculator 
Key tBPS 
Control Panel 
Puzzle 

This gets you back to-----+-Il'I!!I 
the Switcher display 

You return to the Switcher display. 

Returning to the SWitcher display 9 



Cutting and pasting between applications 
Ordinarily, Switcher doesn't transfer the Clipboard from 
application to application. But by using the Option key as you 
switch, you can tell Switcher to transfer the Clipboard so you can cut 
and paste between applications. 

1. Click the switching arrow until you reach MacPaint. 

2. Draw a shape and select it with the lasso. 

3. Choose Copy from the Edit menu. 

4. Hold down the Option key and click the switching arrow until you 
reach the MacWrite screen. 

5. Release the Option key and choose Paste from the Edit menu. 
The shape appears in the MacWrite document. 

10 Chapter 1 : Learning Switcher 



Creating a Switcher document 
A Switcher document lets you automatically start up several 
applications at once. After you've installed the applications you 
want to use together, you can create a Switcher document. The next 
time you want to use those specific applications with Switcher, you 
can start the Switcher document from the Finder; Switcher w ill start 
all the applications for you. 

1. Choose Switcher from the Apple menu to return to the Switcher 
display. 

2. Choose Save Set from the File menu. 

3. Type "Finder/Write/ Paint Set" to name the document. 

4. Click Save. 

~ I nside Disk 

D System Folder Q ~ Inside Disk = 

Eject 

Drille 

Name to salle set as: Salle 

I Finder/Write/Paint se~ Cancel 

Switch to the Finder to see the Switcher document you crealcd . 

• Click the switching arrow until you arrive at the Finder. You'll 
ftnd the Switcher document in Inside Disk with the name you 
gave it. 

c reaftng a Switcher document 11 



. I 

Switcher 

~ 
MlicYrUf 

o 
So,Is1em Fold ... ,. 

Don't erase th"se'! ---------1-t---t D D D 
l./ndoFi!oe 

You might see a few unfamiliar documents as well-these are 
temporary documents, usually invisible, created by MacPaint and 
MacWrite. MacWrite and MacPaint need them to do their work. 
Don't erase them; they'll be erased for you when you close your 
applications. 

Quitting Switcher 
Now you'll quit Switcher and start Switcher again from the document 
you just created. 

You quit Switcher by quitting each application individually and then 
quitting from the Switcher display. 

1. Switch to MacPaint by clicking the switching arrow. 

2. Choose Quit from the File menu. 

3. When you're asked if you want to save any changes, click no. 
MacPaint quits and you return to the Switcher display. 

4. Switch to MacW rite by double-clicking the MacWrite slot. 

5. Choose Quit from the File menu. 

6. When you're asked if you want to save any changes, click no. 
MacWrite quits and you return to the Switcher display. 
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Now you're left with the Finder as the only active application. You 
can qui t Switcher if it has only one application. 

• Choose Quit from Switcher's File menu. 

Switcher quits and returns you to the Finder. The switching arrow is 
gone; Switcher is closed. 

Starting a Switcher document 
Now you'11 start Switcher again, but this time from the Switcher 
document you created . 

• Select the Switcher document FinderIWritelPaint Set and choose 
Open from the File menu (or double-click the Switcher 
document). 

Switcher starts and installs Finder, MacWrite, and MacPaint. This 
takes a few seconds. When Switcher is finished, you're automatically 
switched to the Finder (the application you installed in the first 
slot). You'11 see the switching arrow in the right side of the menu bar 
to remind you that you're using Switcher. You now can switch 
between applications. 

Just for fun ... 
Choose About Switcher from the Apple menu. It gives you some 
helpful hints about using Switcher, and provides an amusing 
diversion in its upper-left corner. 

Just for fun... 13 
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You'll find it easy to work with your usual applications under 
Switcher. This section gives you an overview: how to use Switcher's 
basic features, how to use an application running under Switcher, 
and how to create a Switcher document-your own custom set of 
applications. 

Setting up your disks 
Switcher works best when the applications and documents you'll be 
using are available on disks inserted in the disk drives. Using 
Switcher will be easier if you do some clisk planning before you start. 
If you have a hard clisk, you can use it to hold all your files-system 
files, applications, and documents-and don't have to worry about 
disk arrangement. 

Ideally, all your applications (including Switcher itself) should be 
on the same clisk in one drive, and all your documents should be on 
another clisk in another drive. This arrangement keeps disk 
swapping down to a minimum. (Of course, ideal states aren't always 
possible to achieve.) 

To avoid confusion, you should have system files (Finder, System, 
printing resources, and desk accessory files) on the same disk; if 
your computer uses the hierarchical file system, your system files 
should all be in the same file folder. 

Here are the steps to take to set up Switcher clisks: 

1. Using your backup of the Switcher master disk, copy Switcher and 
the system folder to a new clisk. 

2. Copy as many of your chosen applications to the new Switcher 
disk as will fit. 

3. Insert a clisk into the other clisk drive; this clisk will hold your 
documents. Also use it to hold any applications that won't fit on 
the other disk. 

16 Chapter 2: Using Switcher 
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Applicafton slot 

Starting Switcher 
Start Switcher as you would any other application- by selecting its 
icon in the Finder and choosing Open from the File menu (or by 
just double-clicking the Switcher icon). You'll see the Switcher 
display made up of a window and the familIar menu bar: 

.. file ! .111 Swi tcher ,}t> 

roo Rp pl icfttion Switcher 

).! 

Oouble-cllck here to ltlunch on app licetion ... 

~L-----' 
v 

- :,) 
.~ Double-cUck here to launch on appl ication ... 

----======1 ~ Double-c li ck here to h:lunch en oppl1calion ... r--
:--
~ Double-cli ck here to launch an oppli ce ti on ... 

The window is divided by horizontal lines; the boxes between the 
lines are Switcher's application slots, each one capable of holding 
information about a different application. There are eight 
application slots in all. You can use the scroll bar to scroll to the 
others. The number of application slots you can acrually use 
depends on the amount of memory you have available. 

The Apple and Edit menus are standard. The File and Switcher 
menus contain Switcher commands (the subject of Chapter 3). On 
the right side of the menu bar is the switching arrow. The switching 
arrow appears in the same position in the menu bar of every 
application you use with Switcher. 

Starting SWitcher 17 



Name of installed 
application 

Memory available 
applicafton 

to 

Installing applications 
After you start Switcher you install the applications you want to use. 
You can install all the applications at the outset, or you can install 
one, start working, and add or remove other applications later. 

To install an application, follow these steps: 

1. In the Switcher display, select an application slot by double­
clicking anywhere in it. A dialog box shows you all the 
applications on the disk. 

2. Select the application you want to install and click Open, or click 
the Drive or Eje ct buttons to get applications on another disk. 
Switcher installs the selected application, starts it, and returns 
you to the Switcher display. The display now shows the 
application installed in its slot. 

3. Repeat steps 1 and 2 to continue installing applications . 

.. File ldl1 Switcher <X' 

1m Application Switcher 

• MacWrite II 
128K 

~ Doubl e- cli ck here'tto launch an app l ication ... 

~ Doubl e- cl ick her e to l aunch an Elpp li cation ___ 

~ Double-cl ick here to launch an application " . 

• :. Installing the Finder: Many users find it extremely useful to 
install the Finder in an application slot. Install it just as you 
would any other application-by following the steps you just 
read about. When you use the Finder with Switcher, the Finder 
should always be the first application you install, and it should 
be installed in the first slot. See "The Finder" in Chapter 5 for 
complete details. 
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Installing additional applications 

To install additional applications while you're working, return to the 
Switcher display and repeat the steps for installing an application. 
(You may need to quit an installed application to get enough 
memory for the new application; to do that, choose Quit from the 
application's File menu.) 

USing applications with Switcher 
With Switcher you can work within any of your applications and then 
switch to another at any time. 

Switching to other applications 

There are several ways to switch among applications: 

• Click either side of the switching arrow to move to the next or 
previous application. 

• Press Command-[ to move to the next application; press 
Command-J to move to the previous one. 

• Double-click the application's slot from the Switcher display. 

This switches left ~ ~ This switches right 
' <Xl:' 

~ Rpplication Switc.her . 

C ll C~ here to launch an epP'lI:'BtlOn 
--'-'----___ ....L..I.--.l 

You can begin working with an application as soon as it appears. 
\'V'hen you switch to another application, Switcher preserves your 
document in memory; your document is always ready for you to 
continue working on when you switch back. 
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.:. Switcher Doesn't Save Your Work: Switcher doesn't save your 
work to disk each time you switch. Rather, it preserves your 
document in memory. You need to save your document from 
within its application, just as you do when you're not using 
Switcher. 

Returning to the Switcher display 

To return to the Switcher display at any time, use any of these 
methods: 

• Click the center of the switching arrows. 

• Press Command- \. 

• Choose Switcher from the Apple menu. 

File Edit Search format Font Style 

About MacWrlte... - ~ Untitled ~ 

Choose Printer 
Scrapbook 
"(arm Clock 
Calculator 
Key Caps 
Control Panel 

inch 16111 II I 

Choosing this gets -------i­
you back to the 

SWitcher 00\ 

Switcher display 

Screen saving 

Clicking the center of this arrow also 
gets you back to the Switcher display 

When Switcher moves from application to application, the new 
application's display appears instantly. The display you see is 
actually a kind of snapshot that Switcher takes as you leave an 
application to switch to the next one-you pick up where you left off. 

1his screen-saving function has its costs. When it's on, it uses 22K of 
memory per application. You can free up that much memory for 
Switcher's use by turning Save Screen off. When Save Screen is off, 
Switching time increases slightly because Switcher must redraw an 
application's screen from scratch each time you switch to it. 
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Save Screen turned off 

You turn the Save Screen option on or off by returning to the 
Switcher display and clicking the screen of the Macintosh icon in an 
application slot. In the next figure, the MacDraw™ and MacPaint 
screens are saved between switches, but the MacWrite screen is not 
saved. (The fact that Save Screen is off is indicated by the 
international "No!" symbol-a circle with a line through it.) 

~D' ' Rpplication Switcher ' 

~ e P= 
MacDnp:v !-

1281" 

~ MacVl'n \e ~ ~:' 

12BK 

~ MacPaln\ e 
1281" 

.:. Save Screen Doesn't Save Your Work: The Save Screen option 
has nothing to do with whether or not your work is saved. When 
you switch applications, you don't lose any work whether or not 
Save Screen is checked. You need to save from within each 
application. 

You can decide when you install an application whether to have its 
screen automatically saved each time you install it. See "Save 
Screen" in Chapter 4 for details . 

• :. Inaccurate Displays: Some applications won't be able to 
redraw the display accurately with the Screen Save option 
turned off. An inaccurately redrawn display won't harm your 
document, but it can be annoying . 

• :. Turning Save Screen On Again After you've turned Save 
Screen off, you may not always have enough memory to turn it 
back on, depending on what you've done in the interim. 
Switcher beeps if there isn't enough memory to turn it back on. 
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In case of disaster ... 
If one of your applications appears to be spinning its wheels and 
doing no useful work, or if you get a message with a bomb icon, you 
might be able to recover by returning to the Switcher display. Hold 
down the Option, Command, Shift, and period keys, all at the same 
time. When the problem is specific only to the particular 
application, you can return to the Switcher display by using this 
method, and the other applications won't be affected. (But any 
unsaved changes in the document you were working on will be lost.) 
Otherwise, the problem probably affects shared system software 
and therefore all applications. 

When an application crashes, it may damage the system memory 
shared by all applications under Switcher. To avoid problems, you 
should save each document and quit each application immediately. 
Then quit Switcher and restart your Macintosh by turning it off and 
then on again. 

Using Switcher documents 
A Switcher document contains all the information you need to load 
several applications (and, optionally, several documents) at the 
same time. 

Creating a Switcher document 

The Save Set command in the File menu lets you store in a Switcher 
document information about the current set (the active applications 
in Switcher at a given moment). A Switcher document works much 
like any other Macintosh document: When you start a Switcher 
document from the Finder, the document starts the Switcher 
application for you. The information in the document makes 
Switcher load all the applications and documents that make up the 
set. 
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You can create as many Switcher documents as you want. You could 
have a writing set, for example, that might include a word 
processing program, a spelling checker, and a graphics program 
for creating illustrations. A telecommunications set might have a 
modem program like MacTerminaFM, an editor for storing text 
documents, and a stock analysis program for handling the 
information you got from your on-line broker. Perhaps you'll have 
a finance set- an accounting program, a spreadsheet, a tax analysis 
program, and a database listing the antacids you have in your 
medicine cabinet. 

Creating a Switcher document is simple: 

1. Start Switcher. 

2. Install all the applications you want to use. If you want an 
application to open a particular document, use the Attach 
Document command in the File menu. (See "File Menu" in 
Chapter 3.) 

3. When you're satisfied with the set, choose Save Set from the File 
menu. Switcher asks you to name the set 

[g) I nside Disk 

o System Folder [g) I nside Disk 

Eject 

Driue 

Name to saue set as: Saue 

I Finder/ Write/Paint Se~ Cancel 

After you've saved the set, you can continue working. The next time 
you return to the Finder, you'll see the Switcher document you 
created. 
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Get Info window 

It's a good idea to record information about the set (the name of the 
documents in the set, wbether there's a document attached, and so 
on) in the document's Get Info window. Just select the document 
and choose Get Info from the File menu; then type the information . 

.. File Edit Uiew Special @ 

r:;Q, ~D= Information about Flnder/ lUrlte / Paint Set ~ 

~ 
lb~ 

Finder/ Write/ Paint Set 

.Fnl Ki nd: Switcher document 
Size: 156 bytes. accounts for O.SK on disk: OUISldl' D,s:1:; 
Where: Inside Disk, internal driue 
Created: Monday, May 5, 1986 at 10:23 AM 
Modified: Monday, May 5, 1986 at 10:23 AM 

o locked 

Finder configured for 192K; Write tine! Paint set at 
128K. No docume nts attached. Finder screen off~ -

I 
Loading applications from a Switcher document 
From the Finder.· To start Switcher with a set of applications chosen 
in advance, open a Switcher document from the Finder. Switcher 
will start, install all the applications (and any attached documents), 
and finally switch you to the application installed in the first slot. 

From Switcher: Choose Load Set from the File menu in the Switcher 
display-when the dialog box appears, choose the set you want to 
use. If you've already installed applications and choose Load Set, 
Switcher installs as many applications as memory allows from the 
set you've named. 

See "Load Set" in Chapter 3 for more information. 
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Transferring information between 
applications 
To transfer the Clipboard's contents so that you can cut and paste 
between two applications, hold down the Option key and click the 
switching arrow until you get to the application you want (Using 
Switcher's preset options, you won't be able to copy information 
from one application and then paste that information directly into 
another application; each application under Switcher maintains its 
own separate Clipboard.) 

You can tell Switcher to transfer the Clipboard all the time by 
checking Always Convert Clipboard in the Options dialog box. 
(You get that dialog box by choosing Options in the Switcher menu; 
see "Options" in Chapter 3 for the details.) It takes longer to switch 
between applications when you use this option. 

Quitting applications 
To quit an application, switch to the application, save your 
changes, and choose Quit from the File menu. That application is 
removed from the Switcher environment. Its application slot and 
the memory allocated to it become free and you return to the 
Switcher display. 

Quitting Switcher 
When you want to quit Switcher, you must fust switch to each 
application and choose Quit from the File menu; then return to the 
Switcher display and choose Quit from the File menu, or click the 
close box in the Switcher window. 

You can quit Switcher when only one application is still installed. 
Choose Quit from Switcher'S File menu (or click the close box in the 
Application Switcher window); you'll end up in that application. 

Remember: Switcher doesn't save documents Jar you. Be sure to 
save and quit each application individually- never just tum the 
Macintosh off 
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Show Info Window 

Quit 
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The four menus on the Switcher display are Apple, File, Edit, and 
Switcher. The Apple menu is standard, except when you are in an 
application: The Apple menu includes a return-to-Switcher 
command at the bottom. Nothing in the Edit menu works in the 
Switcher display; use its commands when you're using a desk 
accessory from the Apple menu. 

File menu 
Each item in the file menu is explained in this section. 

Load Set 
This command lets you choose a Switcher document to load. 
Switcher starts each application in the set in turn, leaving you in the 
application that occupies the fIrst slol. The applications and 
documents in the set must be on disks already inserted in your 
Macintosh. If Switcher can't fInd an application or document while 
loading a set, it stops loading and returns to the Switcher display. 

Switcher loads only as many applications as it can fit in memory. 
Before you choose the Load Set command, quit any active 
applications you don't need. 

The Load Set command ignores Back After Launch (described in 
"Switcher Options" in Chapter 4). After Switcher has loaded all 
applications, you're switched to the application that occupies the 
first slot. 

.:. Loading Copy-Protected Software: If Switcher encounters copy­
protected software requiring a "key" disk (such as Microsoft 
applications), the startup disk will be ejected, and then you'll be 
switched back to the Switcher display. You'll need to follow 
these steps: 

1. Reinsert the ejected disk to continue loading applications. 

2. When you return to the application, eject the disk. (Press 
Command-Shift-1 if the disk is in the internal drive, or 
Command-Shift-2 if it's in the external drive.) 

3. Insert the key disk. The application reads it and then ejects it. 

4. Reinsert the correct disk. 



Save Set 
Save Set saves the current set of applications, options, and settings 
as a Switcher document that you can start from the Finder or load 
with the Load Set command. 

After you've saved a set or loaded a set from a Switcher document, 
any changes you make to the set-such as adding or removing 
applications or changing Switcher options-won't affect the 
contents of the saved set in the Switcher document. 

Attach Document 
This command lets you choose a specific document to be opened 
by an application when the application is installed from a Switcher 
document. Here's how to attach a document: 

1. Switch to the Switcher display. 

2. Select a slot with an application name in it. 

3. Choose Attach Document from the File menu. A box appears 
with a list of all documents that the application can open. 

4. Select the document you want to attach and click Open. 

The document's name now appears in the application's slot in the 
Switcher display. If the application is active, the document you just 
selected is not opened: The document currently open in the 
application is not affected. If the application is not active, the 
document will be opened when you start the application. 

MacWri te 

Name of attached document """':::t::---~==:....'(:S"":\:Ch:e:.., :P'''.:'\~' ,--) _ ___ ___ _ _ -'.'!.2e~K~ 

ThinkTank 5 12 
(S'w'Hcher outli ne ) 2S6K 
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Once you've selected a document with the Attach Document 
command, using the Save Set command saves information about 
the attached document in a Switcher document. 

Show Info window 

This command brings up the Switcher Information window-a 
graphic snapshot of the memory use and allocation for the current 
set of applications. You can use this information to help you 
configure your Switcher environment. (See "Configure then Install" 
in Chapter 4 for information on configuring.) 

Amount allocated to applicafton ---------------..... 

Amount available to application "'---1HrU:!<'!'!'!'I£!I4I~ 

Amount being used ------t----jH I-:;;ffii(;;rrr;,--" 128K 
MecP oi nt 126K 
Free Memory J,. i'~-;-. : ... ,,:-,-,:,:, ,:i, .. ,,:.::,.,:;:. ,".'-':':',,"'-' .;).::,',:",;,1 46BK 

Icon of checked application --+---++-%~8< 

Screen representafton of ----1---+--<-;---- -1 
checked application 
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The bar next to each application represents how much memory has 
been allocated. The dark gray area shows how much memory is 
actually being used; the light gray area shows how much additional 
memory is available to the application. (An application doesn't use 
all the memory available to it aU the time.) You'll notice that the 
memory-use numbers don't add up to what you'd expect-512K or 
I megabyte. That's because the Switcher program itself, the 
operating system, and the Save Screen option all use memory. Free 
memory is only an estimate, and Switcher usually understates it. If 
free memory is dose to but slightly less than what you need, you can 
still try to install another application. Switcher will tell you if there's 
not enough memory. 

The application that's currently selected in the Application Switcher 
window has a checkmark next to it and is visually represented by a 
miniature screen. Clicking the miniature screen switches you to that 
application. Switcher won't display a miniature screen if the Save 
Screen option is off for that application. 

Vou can leave the Switcher Information window on your desktop 
and move between it and the Application Switcher window to keep 
track of free memory as you're installing applications. 

Quit 

Quit exits Switcher. Vou can accomplish the same thing by clicking 
the Switcher window's close box. Vou won't be able to quit Switcher 
until you've quit all (or all but one) of the active applications. If you 
quit Switcher with one active application remaining, Switcher leaves 
you in that application with no increase in the amount of memory 
allocated to the application. If you want more memory for the 
application, you'll need to quit and restart from the Finder. 

File menu 31 
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Configur-e then Install ... 
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Options. .. '-: 

3€O 
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32 Chapter 3: Menus 

Switcher menu 
Each item in the Switcher Menu is explained in this section. 

Install Application 
1his command lets you select an application to use with Switcher. Its 
action is the same as double-clicking one of the application slots in 
the Switcher display. If you haven't selected an empty slot, Switcher 
installs the application in the next available one. 

Remove Application 
Remove Application lets you remove a selected nonactive 
application from the current set. (A nonactive application is one 
that Switcher has allocated memory to, but that hasn't started yet) 
A nonactive application has the word configure in its Switcher slot. 
If you try to remove an active application, Switcher reminds you to 
switch to the application and choose Quit from the File menu. After 
you remove an application, its application slot and any memory 
allocated to it become free. 

Configure then Install 
1his command lets you specify information about an application 
and then install it. If you haven't selected an application slot, 
Switcher selects the next available one. If you select a slot with an 
active application, you'll get a reminder that you can't configure an 
active application. See "Configure then Install" in Chapter 4 for 
complete information on configuring options. 

Open 

Open starts a selected nonactive application or switches you to the 
selected active application. 



Switch Left 
Switch Left has the same effect as clicking the switching arrow that 
points left. 

Switch Right 
Switch Right has the same effect as clicking the switching arrow that 
points right. 

Options 
This command presents the Options window, decribed at the 
beginning of Chapter 4. 
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You probably won't need to change Switcher's preset options. But 
Switcher was designed to be flexible. This chapter provides the 
information you need to customize the Switcher environment to 
meet your personal tastes, and to install applications in ways that 
make the most efficient use of memory. 

Switcher options 
You can tailor Switcher to suit your needs and preferences. From 
the Switcher display, choose Options from the Switcher menu. A 
dialog box appears: 

Rpplication Switcher Options 

o Switcher in Rotation 

o Rlways Conuert Clipboard 

{;;<;J Switching Rnimation 

{;;<;J Bacle: Rfter launch 

o Same One Twice 

o Reuerse Switch Direction 

o Disable Keyboard Switching 

Cancel 

Switcher automatically remembers the options you choose from 
session to sessionj you don't have to save them. 

Switcher in Rotation 

Checking this option means that, as you click the switching arrow, 
one of the applications you switch to is the Switcher clisplay. 
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Always Convert Clipboard 

When you use Switcher, each application maintains its own separate 
Clipboard, so you can cut, copy, and paste within each application 
as you normally would. When you check Always Convert Clipboard, 
each time you switch to another application Switcher transfers the 
Clipboard contents from the current application to the next one; 
any old information in the destination application's Clipboard is 
lost. 

It takes longer to switch between applications when you use this 
option. 

You can override the current state of Always Convert Clipboard by 
holding down the Option key as you switch to the next application. 
If Always Convert Clipboard is not checked, then switching while 
holding down the Option key converts the Clipboard contents for 
that particular switch. If Always Convert Clipboard is checked, then 
switching while holding down the Option key will not convert the 
Clipboard contents. 

Switching Animation 

When you check this option, applications appear to roll by as you 
switch. When this option is not checked, the next application 
simply appears. This option is strictly a matter of aesthetic 
preference; it's preset to be checked. 

Back After Launch 

When this option is checked, you return to the Switcher display after 
you install a new application. You can continue installing 
applications, or go directly to the application you want to work with 
by double-clicking its slot. When Back After Launch is not checked, 
you remain in the application you just installed. Switcher ignores 
Back After Launch when you start or load a Switcher document. This 
option is preset to be checked. 
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Back After Launch might interfere with disk-insertion sequences 
when you're installing copy-protected software requiring a "key" or 
master disk. Here's what happens: 

1. The application ejects the disk and asks for the master disk. 

2. Before you can insert the master disk, Switcher takes control and 
returns you to the Switcher display. 

3. Switcher asks for the ejected disk. (Push it in.) 

4. When you switch back to the application, it's still waiting for the 
master disk. You'll need to eject the disk manually (with 
Command-Shift-1 or -2, depending on the drive the disk is in), 
and then insert the master disk. 

To avoid all this, uncheck Back After Launch when you're using 
copy-protected software. 

Same One Twice 

This option lets you run the same copy of an application twice from 
the same disk (useful when you want to work on, say, two different 
MacProject plans at the same time). When it is not checked, 
Switcher lets you start the application only once from a particular 
disk. 

Warning Some applications 0ncluding MacWrite and MacPaint) create 
special temporary files and can get confused deciding which files 
go with which copy of the application. It's safe to start fwo copies of 
an application as long as each copy is on a different disk or (in 
computers using the hierarchical file system) in different folders-in 
which case, you won't need to check Same One Twice. It's never 
safe, however, to run fwo copies of the Finder. 

Reverse Switch Direction 

This is another aesthetic feature. It lets you decide the direction the 
Switcher wheel tums when you click the switching arrow. When this 
option is unchecked, clicking the left side of the switching arrow 
makes the display roll off the left side of the screen, bringing in the 
next application from the right. When this option is checked, 
clicking the left side of the switching arrow makes the display roll off 
the right side of the screen, bringing in the next application from 
the left. Try it for yourself and see what happens. 
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Disable Keyboard Switching 

This option turns off the Switcher Command key equivalents: 
Command-[, Command-J, Command-\ (back slash) , and the 
emergency exit combination Command-Shift-Option-Period. (See 
"In Case of Disaster" in Chapter 2 for details about the emergency 
exit.) Some applications use the same keyboard equivalents to 

represent the ir own functions; unless you check this option, 
Switcher's meaning for the keyboard equivalents takes precedence. 

When you click OK or Cancel, you end up back at the Switcher 
display. 

Configure then Install: allocating memory 
to applications 
Switcher divides up memory and allocates it to different 
applications. Each application works as if it were using a Macintosh 
with 128K; Switcher keeps track of the memory allocations, allowing 
you to switch between applications. 

Allocated Allocated 
10 10 

Application ApplICation 

Total ~ 
Memory '-V a SWilcher & 

Allocated OpSystem 

10 
Appl ication 

Q I F'ee 

7 
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The Configure then Install command in the Switcher menu lets you 
specify the amount of memory to give to an application, changing 
the 128K that Switcher usually allocates. Some applications, 
designed to be used with Switcher, automatically request specific 
amounts of memory without your having to use this command. The 
Finder (version 5.0 and higher), for example, automatically gets 
192K of memory. 

You might be able to allocate more or less memory than an 
application usually requires. If you are working with a memory­
based application such as MacDraw, you might want to allocate 
more memory to MacDraw so you can work with larger documents. 

Here are the steps to take to change the preset memory allocations: 

1. Click an empty application slot in the Switcher display. 

2. Choose Configure then Install from the Switcher menu. 

3. Select an application to install from the dialog box that appears. 

4. When the configuration box appears, make the appropriate 
settings. (See the descriptions following the figure.) 

5. Click Permanent to use these settings each time you use this 
application; click Temporary to use these settings for just this 
session. Click Cancel if you don't want to install this as a 
configured application. 

The application ---------1l===~=====================1l 
being configured. MacPaint Configuration 

If available, the amount----"'it------- ------ -, 
of memolY to allocate Preferred Memory Size I~I 
to the application. . . 

The minimum amount 
o f memolY the applica~on 
needs to work. 

Keeps a copy of the -------H-" 
screen in memory 
between switches. 

Minimum Memory Size 1128 I 

~ Saue Screen 

I Permanent I [Temporary I [ Cancel I 
Changes apply to all future ./"./ 
sessions with this application. ./ 

Changes apply to this ------ -----/ 
session only. 
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Preferred Memory Size 
This is the amount of memory Switcher allocates to the application 
if that much memory is available. The number you see is the 
amount an application requests, a previously configured amount, 
or 128K (Switcher's preset amount). 

Minimum Memory Size 
This is the smallest amount of memory Switcher tries to give an 
application. Minimum Memory Size is either a previously 
configured amount or 128K. 

Switcher first tries to allocate the Prefe rred Memory Size. If there's 
not enough memory, Switcher tries to provide the Minimum 
Memory Size. The absolute minimum allocation in any case is 64K. 

.:. When Minimum Memory Is Too Much: If there's not e nough 
memory [0 use the minimum memory specified, you get an 
error message. You'll see the application in a slot with zero K 
allocated, and the word configure. You can remove the 
application by choosing Remove Application from the File 
menu; or try to free additional memory by turning Save Screen 
off or by quitting another application and restaning the one you 
want to use. You can restart the application by choosing Open 
from the Switcher menu and again choosing options from the 
configuration box. To see how much free memory is available, 
choose Show Info Window from the File menu. 

Save Screen 
When this option is checked, Save Screen is on when the 
application starts. When Switcher moves from application to 
application, the new application's screen appears instantly. The 
screen you see is actually a kind of snapshot that Switcher takes as 
you leave an application to switch to the next one. The cost of 
having this option on is 22K of an application's allotted memory . 
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Permanent 
Clicking the Permanent button installs the application and makes 
the settings in this dialog box apply to all future Switcher sessions for 
that particular application. (The information is attached directly to 
the copy of the application you're using.) The next time you want to 
install the application, you can simply double-click an empty 
application slot in the Switcher display and select the application 
from the directory window: The options you chose will be in effect 
every time you install that application. If you want to change the 
permanent configuration later (for example, if you get an updated 
version of the application and want to replace the old version), quit 
the application and again choose Configure then Install. 

Temporary 
Clicking the Temporary button installs the application and makes 
the settings in this dialog box apply to this session only. Pressing 
Return or Enter is the same as clicking Temporary. 

After you've finished configuring an application by clicking the 
Permanent or Temporary button, you return to the Switcher 
display. The application appears in a slot with the word configure to 
show that the application is nonactive-memory has been allocated 
to the application, but the application has not yet been started. To 
start the application (and thus make it active), double-click its slot 
or choose Open from the Switcher menu. The application starts and 
you return to the Switcher display. 
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Active application 

Nonactive applica lion 

Active applica~on 

.. File f (111 Switcher 

:D Application Switcher 

~ ~ " 
MocDrew 

12BK 

~ 
.. j" • MocWrite (config ure) i i,~' ~ 128K 

i:,.,: 

$ ~ , 
MocPe lnl -

12BK " 

" 

~ Double-click here t o leu nch on application ... 

Configuration notes 

You must change the memory allocation before you install an 
application; otherwise you must use the preset amount. 

<X> 

Many applications might not run correctly (if at all) if you change 
their memory allocations; the only way to tell is to experiment. 

It's difficult to determine the smallest amount of memory on which 
an application can run on, Some applications will tell you right 
away that you've allocated too little memory (you'll get "out of 
memory" messages); memory-based applications such as 
MacDraw won' t be able to open large documents; and some 
applications such as the Finder will work with less memory, but lose 
functionality (the Finder won't be able to remember as many disks 
on the desktop, for example), 

The safest course is to use the preset value-usually 128K. If you want 
to assign a different amount, experiment with nonessential 
information first. 

Configure then Install: allocating memory to applications 43 



Some specific memory situations 
This section talks about specific situations you might encounter after 
you've become familiar with Switcher. 

Installing the maximum number of applications 

To use the maximum number of applications (eight for the 
Macintosh Plus and four for the Macintosh 512K), check a couple of 
things: 

1. Make sure that the Preferred Memory Size of each application is 
128K. Use Configure then Install (described in detail earlier in 
this chapter) to make any necessary changes. (But realize that, if 
you change an application's preset Preferred Memory Size, it 
might not run optimally, or at all.) 

2. Make sure that you've turned off the Save Screen option before 
you start any application; if the Save Screen option is on for any 
application, you won't have enough memory to install the final 
a pplica tion. 

Without changing Switcher's preset options, you can install seven 
applications in a Macintosh Plus or three applications in a 5I2K 
Macintosh. 

If you've already installed all but one of the maximum allowable 
applications and want to install the last one , turn Save Screen off for 
all the existing applications. Then use the Configure then Install 
command in the Switcher menu to load the final application . 

• :. Macintosh XL Owners: You can use these instructions to install 
three 128K applications on a 5I2K Macintosh XL or seven 
applications on a I -megabyte Macintosh XL. 
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Using inconsistent amounts of memory 

The document size of many applications is limited by the amount of 
memory available. If you create a document allocating one size of 
memory to its application, and later try to open that document 
under Switcher while allocating a lesser amount of memory, the 
document might not fit in memory or the application might crash 
altogether. If you have trouble, try allocating more memory to the 
application and opening the document again. 

Using less than 128K of memory 

Some applications can run with less than 128K of memory. Try 
different Preferred Memory Size amounts with the Configure then 
Install command. Most applications will tell you immediately if 
they won't work. 

Using 512K applications in less than 
512K of memory 

Applications designed to work on a Macintosh with at least 512K 
may still be able to work in Switcher with less than 512K memory 
allocated to them. Try installing the application using Configure 
then Install with different Preferred Memory Size amounts. Some 
applications will not work, will give you a system error message (a 
box with a bomb icon in it), or will tell you that there's not enough 
memory and then stop the installation by returning you to the 
Switcher display. Many applications, however, will tell you the 
minimum amount of memory they need to work. 
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Switcher and disk cache software 
Macintosh Plus, Macintosh 512 and other Macintosh computers 
using newer versions of the ROM come with disk cache software that 
you set in the Control Panel. This and similar software packages 
(like RAM disks) work by using the computer's memory to store 
information that the application would ordinarily get from the disk. 
RAM cache and RAM disk software let you work faster, but Switcher 
can't use the memory you've assigned to such programs . 
• :. Changing RAM Cache: If, while you're running Switcher, you 

make changes to the amount of memory set aside for disk 
caches or RAM disks, the changes won't take effect until after 
you quit Switcher. These changes affect Switcher; the more 
memory you put into the RAM cache, the less you have 
available for applications running with Switcher. 

Speed, memory, and safety 
Most of Switcher's features require tradeoffs among speed, memory 
consumption, and safety. This section gives you ideas on how to 
optimize Switcher for your own needs. Speed refers to the amount of 
time it takes to switch between applications. Memory consumption 
refers to options that consume memory beyond what is allocated to 
applications. Safety refers to the configuration and options most 
applications can use without danger of crashing. Because Switcher 
cannot predict how a particular application is designed, some 
options may be more likely to cause problems. 
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Speedy options 
For fastest switching between applications, uncheck Always Convert 
Clipboard and Switching Animation (described in "Switcher 
Options" earlier in this chapter), and turn Save Screen on for each 
application. 

To start Switcher quickly, do any of the following: 

• Save your favorite sets of applications as Switcher documents. 
From the Finder, simply open a Switcher document: Switcher 
installs and starts applications for you . 

• Designate Switcher as the startup application-when you turn on 
your Macintosh and insert a startup disk and any application 
disks, Switcher starts automatically. To set Switcher as the startup 
application, follow these steps: 

1. Go to the Finder. 

2. Select the Switcher application icon. 

3. Choose Set Startup from the Special menu. 

• Designate a startup Switcher document. Follow these steps: 

1. Go to the Finder. 

2. Select the Switcher application icon. 

3. Choose Set Startup from the Special menu. 

4. Rename the Switcher document ·Switcher.startup". 

Switcher will start up automatically and load the set from the 
document. If you don't want Switcher. startup to load, hold down 
the Option key while your Macintosh is starting up. 

Saving memory 
To conserve memory, 

• Allocate as little memory as possible to each application. 

• Quit applications you are no longer using. 

• Turn off the Save Screen option for each application. 
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Safety 

Because Switcher can't predict how spedfic applications are 
designed, some settings are considered risky-they might cause the 
program to crash without warning. The following settings are the 
safest for most applications; Switcher originally starts with them. 
Settings that aren't listed here have no effect on safety. 

Configure Then Install 

Preferred Memory Size 
Minimum Memory Size 
Save Screen 

Options 

128 

128 
On 

Always Convert Clipboard Off 
Same One Twice Off 
Maximum Number of '28K 3 
Applications (Macintosh 512K) 

Maximum Number of 128K 2 
Applications (Macintosh XL. 512K) 

Maximum Number of 128K 6 
Applications (Macintosh XL. 
1 megabyte) 

.:. The biggest safety tip of all- Save your work early and often. 
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Chapter 5 

Particular Software, 
Particular Hardware 
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This chapter gives specific recommendations for using Switcher 
with some of the most popular software from Apple Computer, 
Inc., and provides tips for installing Switcher on specific hardware. 

Software 
This section gives recommended memory sizes and notes about 
several Apple Macintosh applications running under Switcher. 

The Finder 

Preferred Memory Size: 128K (versions 4.0 and higher) 
192K (versions 5.0 and higher) 

Minimum Memory Size: 128K (versions 4.0 and higher) 
192K (versions 5.0 and higher) 

Having the Finder as one of your set of applications gives you the 
speed and flexibility of Switcher as well as most of the utility of the 
Finder, with no time lost returning to the Finder. 

When you use the Finder with Switcher, the Finder should always be 
the first application you install, and it should be installed in the first 
slol. 

To quit the Finder from within Switcher, use either of these 
methods: 

• Switch to the Finder and double-click another application's icon. 
That application is started and installed in the slot previously 
occupied by the Finder. 

• Switch to the Finder and choose Quit from the Special menu. 
(Quit appears where Shut Down usually does.) 

To quit Switcher when the Finder is one of the applications, quit all 
other active applications, leave the Finder active, and then quit 
Switcher. 

If you try to start a Switcher document from the Finder under 
Switcher, the set won't load. Switcher will quit the Finder and return 
you to the Switcher display. 
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When you switch to the Finder, you might see the temporary files 
that other applications are using. These files have a generic icon 
and names like Paintl and Paint2 (!vIacPain!) and UndoFile and 
ScrapFile (MacWrite). Do not remove these files; if you do, you 
might lose information or cause the application to crash. The 
application removes these files when you quit. 

Printing with the Finder in a Switcher application slot can be 
curious. When you install an application with its Same One Twice 
option turned off, you can't print a document of that application 
from the Finder. (Switcher tries to install the application a second 
time.) To print a document from the Finder, turn on the 
application's Same One Twice option . 

• :. Same One Twice: Don't use the Finder with the Same One 
Twice option. 

Font/DA Mover 
Preferred Memory Size, 128K 

Minimum Memory Size, 128K 

Don't use FontlDA Mover while any other applications are active in 
Switcher. FontlDA Mover alters the System File, and this could 
cause problems with other active applications . 

• :. Same One Twice: Don't use Font/DA Mover with the Same One 
Twice option. 

MacDraw 
Preferred Memory Size, 128K or more 

Minimum Memory Size, 128K 

When using MacDraw under Switcher, don't use more than 
approximately 80% of the application's memory. Don't copy or 
paste when copying or pasting would use more than 80% of 
memory. (Use the About MacDraw command in the Apple menu to 
check your memory usage.) MacDraw is likely to crash when 
memory used exceeds 8()o1o. 
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MacPaint 
Preferred Memory Size: 128K or 179K 

Minimum Memory Size: 128K 

Run MacPaint only at memory sizes of 128K or 179K. 
.:. Same One Twice: Don't run MacPaint with the Same One Twice 

option. 

MacProject 
Preferred Memory Size: 128K 

Minimum Memory Size: 128K 

MacWrite 
Preferred Memory Size: 128K (144K to use LaserWriter) or more 
Minimum Memory Size: 128K (l44K to use LaserWriter) 
.:. Same One Twice: Don't run MacWrite with the Same One 

Twice option. 

Installer 
Never use Installer with Switcher. For technical reasons, these two 
applications cannot happily coexist. 
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Hardware 
This section makes specific recommendations about using Switcher 
with hard disks, with the Apple LaserWriter printer, and with the 
Macintosh XL computer. 

Hard disks 
Copy Switcher to the hard disk. Always start from the hard disk. Be 
sure to keep all your system files in the same hard disk volume. If 
you're using the hierarchical file system, keep all your system files in 
the same folder. 

LaserWriter 
Follow the LaserWriter software installation procedures. In general, 
printing on the LaserWriter calls for more memory than printing on 
other types of printers. Most Macintosh software will print fine with 
the 128K minimum, but you might need to experiment with 
different memory amounts occasionally. (For example, you'll need 
to install MacWrite with a Minimum Memory Size of 144K.) 
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Macintosh XL 
Switcher works well with a Macintosh XL with either 512K or 
1 megabyte of memory, running MacWorks™ (software that allows a 
Macintosh XL to run Macintosh software). Here are a few things you 
should know about Switcher and the Macintosh XL: 

• Copy Switcher to the XL's hard disk and always start Switcher 
from the hard disk. 

• A 512K Macintosh XL does not equal a Macintosh 512K. 
MacWorks needs 128K of memory, so only 384K is available to 
Switcher. This means you can install two 128K applications while 
using Switcher's preset options, or three 128K applications with 
the Save Screen option turned off. (See "Installing the Maximum 
Number of Applications" in Chapter 4.) 

• On a I-megabyte Macintosh XL, you can install six I28K 
applications while using Switcher'S preset options, or seven I28K 
applications with the Save Screen option turned off. (See 
"Installing the Maximum Number of Applications"in Chapter 4.) 

• The Finder needs I28K Minimum Memory Size in order to work 
on a Macintosh XL. 

• You can't install Macintosh Pascal in Switcher on a 
Macintosh XL. 
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The Switcher'" program for the Macintosh'" personal computer allows you to 
work with more than one application in memory at the same time. With the 
Switcher, you can move back and forth between Ivlacintosh programs-and 
exchange information between them - as quickly and easily as you move 
back and forth between papers on your desk. By enabling you to create your 
own "integrated applications," the S,,~tcher can help you work faster and 
more productively. 
Software Compatibility 
The Switcher works with most Macintosh applications. The best way to use it 
is with pretested Switcher configurations included on progranl disks from 
Macintosh sofrware developers. If you have any questions about software 
compatibility, ask your authorized Apple dealer or contact the software 
developer. 
The Switcher Construction Kit 
This manual and the accompanying disk contain all the information you need 
to construct, test, and create your own configurations for the Switcher. 
We cannot guarantee the reliability of any particular application or 
combination of applications used with the Switcher. This manual, however, 
provides information to help you to maximize the reliability of applications. It 
also identifies potential problem areas and contains reconunended 
configurations. 

Hardware Requirements 
The Switcher requires a Macintosh with at least 512K of memory In addition, 
we strongly reconunend an external disk drive or hard-disk drive to hold 
additional applications and documents. 
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Update 

Switcher 5.0 

The enclosed Switcher™ disk includes new system software from 
Apple (System 3.2 and Finder 5.3). This improved system software 
increases the performance and reliability of your MacintoshtM 

computer. You should use this system software or later versions as 
they become available at your authorized Apple dealer. 

Because t.his new system software requires more memory to run than 
previous versions, you may have less room to work with 
applications in Switcher. Specifically, 

• If you're using a Macintosh with only S12K of memory, you won't 
ha.ve_enough memo(j( tQ install ;l.1! ID.ree of the applications_a., 
shown in the "Learning Switcher" example. Choose two of the 
three shown. 

• Many applications that once worked in a 128K slot in Switcher 
may now require more memory to work dependably. This is 
especially true if you are using a LaserWriter or LaserWriter Plus 
printer. 

• Most applications will require more memory if you're working 
with large documents or if you're using the Attach Document 
command to load large documents. 

• If you experience problems with applications installed in a 128K 
slot in Switcher, try using the Configure then Install command to 
assign more memory to the application. The Switcher manual 
explains how to do this. 

In general, if you have problems with an application working 
dependably in Switcher, experiment with giving the application 
more memory. 
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